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What can one do with Inviwo?
– Quick demonstration –



• Getting started

• Overview

• High-level abstractions

– Visualization pipeline creation/editing

• Mid-level abstractions

– Python

– Web

• Low-level abstractions

– Data handling

– C++ 

• Application use cases

Outline



• Recommended way: github.com/inviwo

• Just wanna try it out (binaries): inviwo.org

Getting started

inviwo.orggithub.com/inviwo

https://github.com/inviwo/
http://inviwo.org/


a. Setup software environment

1. Git client (SourceTree, GitKraken…)

2. CMake cmake.org/download/

3. Qt www.qt.io/download

4. C++17 compiler of your choice (MSVC/Clang/Gcc)

5. Optional: Python 3.x

b. Get source code

Building from source

git clone --recurse-submodules https://github.com/inviwo/inviwo.git

https://cmake.org/download/
http://www.qt.io/download
https://github.com/inviwo/inviwo.git


c. Run CMake

1. Specify source/build directories

2. Configure and generate project

d. Open in chosen developer IDE

1. Compile

2. Run and make magic ☺

Building from source (cont.)

Build should not be in source directory !



Overview



• Research software

• Developed by Visualization groups at

– LiU, KTH, UULM

• Liberal license (Simplified BSD)

– you can use it commercially

Overview

D. Jönsson, et al., “Inviwo – A Visualization System with Usage
Abstraction Levels” in IEEE Transactions on Visualization & 
Computer Graphics, 2019.
doi: 10.1109/TVCG.2019.2920639



• Pure C++ Core

• Modular system 
(plugins)

• Multiple Apps

Architecture



Module system (plugins)
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Base

Plotting PlottingGL

OpenGL

UserInterfaceGL

BaseGL

FontrenderingHDF5

Python PythonQt

QtWidget

…

• Modules depend on Core 
and/or other modules

• Modules can wrap external libs

– Data readers, OpenGL, …

• Enable them in CMake (IVW_MODULE_...)



• Useful modules with external dependencies (e.g. boost) 

– OpenMesh

– DICOM (Grassroots)

– Topology Toolkit (TTK)

– Tensor vis

External modules – github.com/inviwo/modules

Add module paths to IVW_EXTERNAL_MODULES

https://github.com/inviwo/modules


• Imaging data

– DICOM, H5, TIFF stack, RAW, nifty, pvm, …

• Mesh data via Assimp

– Collada, 3Ds, fbx, obj, ...

• Various image formats

– Jpeg, TIFF, PNG, ...

• Not enough?

– Write your own!

Supported data formats in existing modules



High-level abstractions
– The network editor



• Source Processor has no inports

• Sink Processor has no outports

• Evaluation starts at Source Processor and ends at Sink Processors

Processor

• Uses data from inports

• Operates on data

• Outputs result on outports



Visualization pipeline – processor network

• Models a data-flow graph

• Data enters at the top

• Result at the bottom

• “Stateless”

𝑓𝑝4 𝑔𝑝3 ℎ𝑝1 𝑖𝑛𝑝𝑢𝑡1 , 𝑘𝑝2 𝑖𝑛𝑝𝑢𝑡2

Feline calicivirus



Data/information flow

• Processors

– Lazy evaluation

• Connections

– Pass data downwards

– Pass events upwards

• Links

– Synchronize property 
states between processors



Network editor – Create/edit visualization pipelines
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Processor
Network



Output



Property
List



Message Console



Properties

• Configurable processor parameters

Select processor



Property Data types Description

StringProperty String Text input

BoolProperty Boolean Checkbox

OptionProperty enum, string, float/double, integer List item selection

OrdinalProperty
float/double, integer, vector {2,3,4} , 
matrix{2,3,4}{2,3,4}

Bounded number input

MinMaxProperty float/double, integer, vector {2,3,4} Range with start-end values

ButtonProperty - Callback action on click

TransferFunctionProperty TransferFunction/Iso-values Map values to colors and opacity. Colormap

FileProperty
DirectoryProperty
FilePatternProperty

string(s)
File/folder paths. Also with pattern matching 
(image###.*)

EventProperty Event Map user input to callbacks

ListProperty Any property type User can add/remove properties dynamically

CameraProperty Camera (position, direction…) Camera interaction

CompositeProperty Group of properties



Property Semantics

Spinbox

Color

Ordinal vec4 property

Default

Text

Widget

Transfer function property

Position

Default

Text

Min max property

Default

Text

Spinbox

Angle

Ordinal double property

Accessible via context 
menu of the property



Property Linking

Double click link to 
open Link Editor



Visual debugging

• Concept: Port inspector

– Is an Inviwo workspace

• Concept: Port trait

– Programmatically show data attributes

– Defines port color

• Easily add one for your port type

– yourmodule/data/workspaces/portinspectors

– Register in module constructor

registerPortInspector(PortTraits<ImageOutport>::classIdentifier(),
app->getPath(PathType::PortInspectors, 
"/imageportinspector.inv"));



Mid-level abstractions
– Python and Web integration



• Network-level scripting

– Built-in Python editor for running scripts

• Processor-level 

– Interactive prototyping via PythonProcessor

• Processor from a python script

• Python package

– Run Inviwo from within python

• Integrated data handling

– volume/image/layer/buffer <-> numpy

Python



Python Editor

More examples in inviwo/data/scripts/

Access property path
via context menu



• Utilizing everything python offers

– data import, parsing, …

• Skeleton processor via menu

– Ports and properties can be added

Python processor
# Name: PythonTestProcessor
import inviwopy as ivw

class PythonTestProcessor(ivw.Processor):
def __init__(self, id, name):

ivw.Processor.__init__(self, id, name)
self.inport = ivw.data.ImageInport("inport")
self.addInport(self.inport, owner=False)
self.outport = ivw.data.ImageOutport("outport")
self.addOutport(self.outport, owner=False)

self.slider = ivw.properties.IntProperty("slider", "slider", 0, 0, 100, 1)
self.addProperty(self.slider, owner=False)

@staticmethod
def processorInfo():

return ivw.ProcessorInfo(
classIdentifier = "org.inviwo.pythontestprocessor", 
displayName = “PythonTestProcessor",
category = "Python",
codeState = ivw.CodeState.Stable,
tags = ivw.Tags.PY

)

def getProcessorInfo(self):
return test.processorInfo()

def initializeResources(self):
print("init")

def process(self):
print("process: ", self.slider.value)
self.outport.setData(self.inport.getData())



Python processor demo



Python processor – flickr_api

# Name: FlickrImportMinimal

import inviwopy as ivw

import numpy as np
import flickr_api

import requests
from PIL import Image

class FlickrImportMinimal(ivw.Processor):
def __init__(self, id, name):

# flickr authentication (see flickr_api docs)

flickr_api.enable_cache()
self.photos = []
...



Python processor – flickr_api (cont.)

...
def initializeResources(self):

self.photos = []
w = flickr_api.Walker(flickr_api.Photo.search, tags="brno", media="photos")
for i,photo in enumerate(w):

self.photos.append({'url' : photo.getPhotoFile('Medium'), 'title' : photo.title})

self.slider.maxValue = len(self.photos) - 1

def process(self):
r = requests.get(self.photos[self.slider.value]['url'], stream=True)
r.raw.decode_content = True

img = Image.open(r.raw).transpose(Image.FLIP_TOP_BOTTOM)
npImg = np.array(img).transpose((1, 0, 2))

image = ivw.data.Image(ivw.data.Layer(npImg))

self.outport.setData(image)



Python package – run Inviwo in Python

For full example see  inviwo/apps/inviwopyapp/inviwo.py

import inviwopy as ivw
import inviwopyapp as qt

if __name__ == '__main__’:
# Inviwo requires a logCentral
lc = ivw.LogCentral()
# create and register a console logger
cl = ivw.ConsoleLogger()
lc.registerLogger(cl)

# create the inviwo application
app = qt.InviwoApplicationQt()
app.registerModules()

# load a workspace
app.network.load(app.getPath(ivw.PathType.Workspaces) + "/boron.inv")

# start the event loop
app.run()



Web integration

• Run HTML5/WebGL in Inviwo

– User interface

– Plotting

– Etc.



How does it work?

Chromium Embedded
Framework

HTML/CSS/Javascript

Property changed

Set property

Javascript/JSON

Webpage rendered

Mouse/Key events
WebBrowser::invokeEvent(…)

WebBrowser::process()

Inviwo



<html>
…
<body>
<p>Line width<input type="range" min="1" max="100" value="50" class="slider“ 
id="lineWidth"></p>

<script language="JavaScript">
// Initialize Inviwo API so that we can use it to synchronize properties
var inviwo = new InviwoAPI();

// Example: Get property from Inviwo
inviwo.getProperty("LineRenderer.lineWidth",

function(prop) {
// Get HTML element and set its value
var elem = document.getElementById("lineWidth");
elem.value = prop.value;

}
);

// Example: Subscribe to property changes

// Callback for property changes, need to be in global scope.
function syncLineWidth(prop) {

var elem = document.getElementById("LineRenderer.lineWidth");
elem.min = prop.minValue;
elem.max = prop.maxValue;
elem.step = prop.increment;
elem.value = prop.value;

}
// Update html element when the corresponding Inviwo property changes
inviwo.subscribe("LineRenderer.lineWidth", syncLineWidth);
</script>

Code example
See: File->Example Workspaces->WebBrowser



Low-level abstractions
– the C++ world



• Option 1: Tools->Create Sources->Add Module

– Go to yourrepo/modules/
and specify module name (MyModule)

– Run Cmake

• Option 2: Command line

– Go to build/bin/<config>/

– Run ./inviwo-meta-cli –m path/MyModule

– Run CMake

• Creates module structure and CMake file

Creating a module



• Option 1: Tools->Create Sources->Add Processor

– Go to yourmodule/src/processors

and specify Processor name (FancyProcessor)

– Run CMake

• Option 2: Command line

– Go to build/bin/<config>/

– Run ./inviwo-meta-cli –p path/FancyProcessor

– Run CMake

• Creates header and source files

– Added to mymodule/CMakeLists.txt

– Processor registered in MyModule constructor

Creating a processor

registerProcessor<MyFancyProcessor>();



Processor – skeleton (cont.)

#pragma once

#include <inviwo/fancything/fancythingmoduledefine.h>

#include <inviwo/core/common/inviwo.h>

#include <inviwo/core/processors/processor.h>

#include <inviwo/core/properties/ordinalproperty.h>

#include <inviwo/core/ports/imageport.h>

class IVW_MODULE_FANCYTHING_API FancyProcessor : public Processor {

public:

FancyProcessor();

virtual ~FancyProcessor() = default;

virtual void process() override;

virtual const ProcessorInfo getProcessorInfo() const override;

static const ProcessorInfo processorInfo_;

private:

ImageOutport outport_;

FloatVec3Property position_;

};



Processor – skeleton (cont.)

// The Class Identifier has to be globally unique. Use a reverse DNS naming scheme

const ProcessorInfo FancyProcessor::processorInfo_{

"org.inviwo.FancyProcessor",  // Class identifier

"Fancy Processor",            // Display name

"Undefined",                  // Category

CodeState::Experimental,      // Code state

Tags::None,                   // Tags

};

const ProcessorInfo FancyProcessor::getProcessorInfo() const { return processorInfo_; }

FancyProcessor::FancyProcessor()

: Processor()

, outport_("outport")

, position_("position", "Position", vec3(0.0f), vec3(-100.0f), vec3(100.0f)) {

addPort(outport_);

addProperty(position_);

}

void FancyProcessor::process() { outport_.setData(myImage); }



Documentation



• Volume

• Layer

• Image

– Consists of layers

– Color, depth, picking

• Buffer

• Mesh

– Buffers

– Index Buffers

Data structures
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• Ports hold data (shared pointer)

– Inport is const (std::shared_ptr<const Volume>)

– Assign new data to outport (std::shared_ptr<Volume>)

• Data representations

– Type-erased data (void*, and size)

– VolumeRAMPrecision<type>

– VolumeGL

– VolumeCL

• Dispatching to obtain types (similar to VTK)

How to access data



How to access data – VolumeRAM

auto scaleVolume = [](auto ram) {

using ValueType = util::PrecisionValueType<decltype(ram)>;

const size3_t dims = ram->getDimensions();

auto dstRam = std::make_shared<VolumeRAMPrecision<typename ValueType>>(dims);

const ValueType* srcData = ram->getDataTyped();

ValueType* dstData = dstRam->getDataTyped(); 

for (size_t i = 0; i < (dims.x * dims.y * dims.z); ++i) {

dstData[i] = srcData[i] * ValueType(2);

}

return std::make_shared<Volume>(dstRam);

};

auto volume = inport_.getData()->getRepresentation<VolumeRAM>()

->dispatch< std::shared_ptr<Volume> >( scaleVolume );

outport_.setData(volume);

VolumeInport inport_("inport");

VolumeOutport outport_("outport");
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Dispatch function; 
gets called with correctly deduced typeReturn type of dispatch



• Access OpenGL texture ID

• Upload data

How to access data – VolumeGL
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auto dstVolume = std::make_shared<Volume>(size3_t(1, 1, 1), DataFormat<float>::get());

VolumeGL* volumeGL = dstVolume->getEditableRepresentation<VolumeGL>();

float* data = ...;

volumeGL->getTexture()->uploadAndResize(data, size3_t(32, 32, 32));

auto volume = inport.getData(); 

const VolumeGL* volumeGL = volume->getRepresentation<VolumeGL>();

std::shared_ptr<const Texture3D> tex = volumeGL->getTexture(); 
GLuint textureID = tex->getID();

glBindTexture(GL_TEXTURE_3D, textureID);



Application show cases
– what’s possible



.org

D. Jönsson, et al., “Inviwo - A Visualization System with 
Usage Abstraction Levels” in IEEE Transactions on 
Visualization & Computer Graphics, 2019.
doi: 10.1109/TVCG.2019.2920639

Need help?

inviwo.slack.com


